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Introduction 

Preview 
The ASTRO Digital Interface Unit 3000 (DIU) enables remote control of a digital ASTRO base station using 
existing analog desktop controllers, consoles, and other analog non-ASTRO remote control devices. In addition, 
the DIU adds the ASTRO digital encryption capability to the existing analog remote control equipment.  
 
The ASTRO DIU Configuration Service Software (CSS) package enables setting the DIU configuration in the 
field by modifying the DIU internal parameters. The CSS is PC-based software from Motorola that is used to 
program features into DIU units to customize their operation. This User’s Guide describes the installation of the 
DIU Configuration Service Software and attaching the DIU to your computer. It also includes a description of 
the operation of the software, including the screen structure, menus, the keyboard commands, and the program 
tree. 
 

Programming Kit 
The programming kit consists of the following: 
 

 ASTRO DIU CSS installer, available on CD-ROM, part no. DLN7670A. 
 This User's Guide, Publication No. 6802972C90-O. 

 

Who Should Use This Guide 
This Guide is intended for anyone who will use the CSS to program the DIU unit. 

What to Look For In This Guide 
This guide is organized as follows: 
 

 Section 1 describes the CSS installation process. 
 Section 2 provides an overview of the CSS and provides information about  how to obtain on-line help 

and navigate through the user interface. 
 Section 3 explains the hardware setup required for programming DIU unit. 
 Section 4 explains the CSS configuration. 
 Section 5 is a tutorial that provides step-by-step tutorial with instructions on how to perform selected 

tasks using the CSS. 
 
The Appendices contain: 
 

 Appendix A:  Keyboard shortcuts 
 Appendix B:  Troubleshooting information 
 Appendix C: Contact information for Motorola technical support 
 Appendix D:  Acronyms and Abbreviations 
 Appendix E:  Glossary 

 
 
Note: This guide assumes that you are familiar with basic Windows operations. If this is not the case, be sure to 
read the documentation that came with your version of Windows before you proceed. 
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What to Look for Online 
This manual is designed to supplement the on-line help installed with the CSS. Be sure to refer to the on-line 
help for context-sensitive information about the following: 
 

 Codeplug parameters 
 CSS functions 
 CSS services 

 

Conventions Used in This Manual 
The following conventions are used throughout this manual: 
 

Italics Used for emphasis and for new terms. 
Bold Used to indicate keyboard keys or application buttons. 
File/Open Used to designate the location and name of a CSS menu function. For 

example, File/Open refers to the Open function in the File menu. 
Tips: Denotes tips and hints on using the CSS. 
Note: Indicates an operational procedure, practice, or condition to which 

you should pay special attention. 
CAUTION: Alerts you of conditions which can result in loss or corruption of 

data, or damage to application files. 
 

Table 1. Conventions in This Document 
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Section 1: Installing the Software 

System Requirements 
The ASTRO DIU 3000 CSS requires an IBM® PC or 100-percent compatible computer with the following 
minimum configuration: 
 

 Processor Pentium 3 or later 
 Memory (RAM) 128 MB 
 Free hard disk space for installation 20 MB 
 CD-ROM drive only 
 Operating systems Microsoft Windows XP, Windows 2000 
 One serial port 
 Programming cable, Motorola part no. 30-80385B23 and RJ45 to DB25 adapter, part no. 58-80385B30 
 DB25 to DB9 cable adapter, Motorola part no. 01-80379B69 

 

Installing the CSS from CD-ROM 
The installation program is included on the supplied CD-ROM. In order to install the CSS on a hard drive, do the 
following: 
 

 Quit all Windows applications to ensure a successful installation. 
 Insert the CD-ROM into its drive. 
 Start the Windows Explorer. Navigate to CD-ROM root directory and double-click Setup.exe to run 

CSS installation. The setup program will run InstallShield ® Wizard to guide you through the 
installation process.  

 When the Welcome screen appears, read the instructions and click Next. 
 In the Choose Destination Location screen, click Next to install the CSS in the default location. To 

select a different installation directory, click the Browse button.  
 Select the desired Program Folder and click Next to begin the installation. 
 When the setup is complete, click Finish to exit setup. 
 Restart your computer. Once the CSS is installed, you can routinely launch the CSS from the Windows 

Start menu or using the desktop shortcut (if created). If the CSS does not start up as described above, 
see Appendix B, Troubleshooting Information. 

 
CAUTION: Do not delete or move any files installed with the CSS.  
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Section 2: Configuration Service Software (CSS) Overview 

Getting Around in the CSS 
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Figure  1. CSS Main Application Window 

 
Every CSS function can be accessed through the menus, tool bar, or functionality bars. In addition, keyboard 
shortcuts (as described in Appendix A) allow access to most usable CSS functions. Every codeplug parameter 
can be accessed from the Codeplug Tree. These methods of navigation are explained below.  
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Title Bar  
The title bar is located along the top of a window. It contains the name of the application Codeplug File name, if 
codeplug data is loaded.  
 

 

 

Figure 2. CSS Title Bar 

 
Note:  
To move the window, drag the title bar. You can also move dialog boxes by dragging their title bars. 

Menu Bar  
The CSS Menu Bar consists of four menu items (see figure 3): 
 

 
 
 

 

Figure  3. CSS Menu Bar 

 

The Codeplug menu allows you to perform standard codeplug file/device management functions. These 
functions are listed below: 

Read From File Reads the Codeplug from existing file. 
Save Saves a Codeplug to the file. 
Save As Selects a location to save a file; creates a backup 

codeplug file. 
Close Closes the active document. 
Read Device Reads a codeplug data from device. 
Write Device Writes a codeplug data to device. 
Print Prints a codeplug. 
Print to file Prints a codeplug to a file. 
Print Setup Changes the printer and printing options. 
Exit Exits CSS. 

Table 2. Codeplug Menu Functions 
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Services Menu 
 
The Services menu allows access to certain DIU hardware and software configuration parameters, the DIU error 
list, and diagnostic information. Prior to accessing the services screens, the codeplug must be loaded into your 
computer's memory (via the READ functions). You can access the following features through this menu: 
 
 
 

Show DIU Configuration Provides information on the version 
numbers of the various DIU software 
parts and on the DIU hardware 
configuration. 

Make DSP Tune-up Used to CHANGE/VIEW some 
Special Tuning parameters related to 
the DSP. These parameters may need 
to be changes during system setup. 

Make EMC Tune-up Allows programming of new EMC 
default parameters. Use this function 
only for the rare occurrence of an EMC 
software upgrade. 

Monitor DIU-CSS traffic Allows viewing messages that the DIU 
sends over the RS232 link. 

Show DIU Error List Allows reading and viewing the current 
error list from the DIU. 

Table 3. Services Menu Functions 

View Menu 

The View menu offers the following commands: 

Toolbar Shows or hides the toolbar.  
Status Bar Shows or hides the status bar.  

Table  4. View Menu Functions 

Help Menu 

The Help menu offers the following commands, which provide you assistance with this application:  

Help 
Topics 

Offers you an index to topics on which you can get help. 

About Displays the version number of this application. 

Table  5. Help Menu Functions 

 
Refer to the context-sensitive help to familiarize yourself with the functions you can perform from each menu. 
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Tool Bar  
The CSS tool bar (figure 4) includes buttons for some of the most common operations: 
 

 
 
 
 
 

 

Figure  4. CSS Tool Bar 

 
 
 

About Displays the version number of this application.  
Print Allows printer setting; prints currently loaded 

codeplug. 
Communication 
port settings 

Selects the serial port through which the CSS 
computer is connected to the device. 

Sound 
properties 

Selects the sound that will be played by the 
functionality table error notifications.  

Help Provides context-sensitive help. 
 

Table  6. CSS Tool Bar 
 
Tips: 
Refer to the context-sensitive help to familiarize yourself with the functions you can perform from the tool bar. 
For tips on toolbar button functions, make the application window active and hold the cursor over each button 
without clicking.  
 
To display or hide the toolbar, choose Toolbar from the View menu. 
 
 
Keyboard Navigation  
 
Use some of the keyboard keys to navigate through the CSS and to change field values. The keyboard shortcuts 
that you can use to navigate through Codeplug spreadsheets are listed in Appendix A. 
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Codeplug Tree View  
The CSS displays the DIU codeplug in a tree structure. To display a codeplug page, click the desired entry. A 
codeplug must be loaded into your computer's memory (via the Read Device or Read File functions) before you 
can access the codeplug parameters. You may edit an archive file without a DIU connected. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure  5. CSS Codeplug Tree 
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Functionality Bar  
The Functionality Bar is located on the left-hand side of the document window. It displays the shortcuts to the 
ASTRO DIU 3000 Codeplug Menu and Services. To perform an action, click the desired entry.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure  6. CSS Functionality Bar 

 

Status Bar  
The status bar is located at the bottom of the document window. It displays information about a command or 
toolbar button or an operation in progress. 
 
Codeplug Structure 
Before you can access the codeplug parameters, a codeplug must be loaded into your computer's memory (via 
read device or read file functions). You may edit an archive file without a device connected and save your 
modifications in that or a new archive file. 
  
CAUTION:   
Editing the codeplug parameters does NOT actually modify the DIU codeplug data, but rather modifies a copy of 
the data retrieved from the DIU codeplug (or archive file) via read device or read file functions. After all 
modifications are completed, you MUST program the changes back into the DIU or SAVE them to a new 
archive file. Otherwise, the modifications will be lost when you exit the CSS. 
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Note:  
In some cases, a system configuration must be ENABLED to allow you access to its corresponding parameter 
screen. For example, the ASTRO SmartZone System parameter must be enabled before you can view the 
ASTRO SmartZone Parameters screen. Note that the corresponding parameter screen may be more than one 
level below the configuration screen. For example, the TRC Console configuration must be enabled before 
accessing the TRC Console screen under the Consoles and Microphones parameter screen. 
  
 
Codeplug parameters are divided into several different sections: 
 

Codeplug Tab Codeplug Parameters Tab Description 
ASTRO DIU 
3000 System 
Parameters 

Encrypted System 
Analog Mode Support  
Centracom Signalling Link  
RNC Link 
Data & OTAR Support 
Analog Console 
Handset User 
MRTI Phone Patch 
ASTRO Trunking System 

Used to view/change the DIU 
ASTRO system configuration 
parameters 

Alert Tones Alert Tone Level 
Alert Clear TX 
Alert Clear RX 
Alert TX Key Fail 
Alert RX Key Fail 
Alert Key Reset 
Data Busy Tone 

The Alert Tones screen is used to 
view/change the DIU alert tones 
parameters. These parameters 
should be selected during system 
setup. 

Console and 
Microphones 

Digital, TRC Console 
  TRC Tuning, 
  Function Tone 
Frequencies, 
  TRC Functionality Table, 
  Console Interfaces 
RNC 
Microphone Sensitivity 
E&M Console 
  E&M Console Interfaces, 
  E&M Console Functions, 
  MRTI 

Used to CHANGE/VIEW console 
and RNC specific information 
such as guard tones, tone duration, 
TRC functionality table and 
console/RNC interface definitions.  
 

Common Air 
Interface (CAI) 
Data 
Definitions 

CAI Data Port 
Number Of Data Transmit 
Attempts 
Acknowledge Timeout 
CAI Individual Address 
 

The CAI Data Definitions screen 
is used to view/change the 
parameters controlling how the 
DIU handles Common Air 
Interface Data. To enter this 
screen, "Data & OTAR Support" 
must not be disabled in the System 
Parameters screen. 
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Codeplug Tab Codeplug Parameters Tab Description 

Base Station Line Level 
Fast Unmute 
Link Type 
Digital Link Check 
Carrier Detect 
Analog Link Check 
V.24 Clock Source 
Analog Call Timeout 
Silent Level 
Smartnet System Address Of  
   The Station 
Smartnet System Address Of  
   The DIU 

The Base Station screen is used to 
view/change parameters related to the 
interface to the ASTRO base station 
connected to the DIU. These parameters 
should be selected during system setup. 
  
Note:  
Some parameters on this page will not 
be available based on the context. 
 

Encryption 
parameters 

Encryption Configuration 
APCO Key Management  
   Definitions  
FIPS Role Users 

Used to CHANGE/VIEW encryption 
parameters including basic parameters 
of the encryption module, key indexing, 
and FIPS information. These parameters 
should be selected during system setup.  
 
Due to security restrictions, encryption 
parameters cannot be stored in archive 
files. You must download the 
encryption parameters from a DIU 
before viewing them.  
 
These restrictions are implemented to 
conform Federal standards for 
encryption user access. 

ASTRO 
Trunking 
Parameters 

SmartZone Parameters 
SmartNet Parameters 

Used to CHANGE/VIEW the DIU 
ASTRO SmartZone and Smartnet 
parameters.  These parameters should 
be selected during system setup. 
 

TX Default 
Attributes 

Digital, TRC,  
SN Console Default TX  
   Attributes 
Interconnect/Phone Patch  
   Default TX Attributes 
Handset ("DIU Local User")  
Default TX Attributes 
E&M Console Default TX  
   Attributes 

Defines the default attributes to be used 
upon transmission from the various 
control equipment connected to the 
DIU.  This equipment includes 
handsets, consoles, and phone patch. 
 
In each case different attributes can be 
used, such as self-ID, channel, and TX 
mode. These parameters should be 
selected during system setup. 
 

Table 7. CSS Codeplug Description 
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Section 3:  Hardware Setup 

How To Connect The ASTRO DIU 3000 Device  
To communicate with the DIU device, do the following: 
 

 Connect the programming cable (Motorola Part No. 30-80385B23) to the DIU ‘COMPUTER’ port.  
 Connect the RJ45 side of the RJ45-to-DB25 adapter (Motorola Part No. 58-80385B30) to the 

programming cable.  
 Connect the DB25 side of the RJ45-to-DB25 adapter to your PC serial port. Refer to your computer 

owner's manual for the location of the serial ports.  
 
Note: 

 If using a PC computer with a DB9 type serial port, connect the DB25-to-DB9 adapter (Motorola Part 
No. 01-80379B69) between the computer and the DB25-to-DB9 adapter.  

 
RJ45 DB25 Female DB9 Female Description 
7 2 3 Receive Data 
2 3 2 Transmit Data 
8 7 5 Ground 

Table 8. RJ45, DB25, DB9 Connector Pin Description 
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Section 4: CSS Configuration  

Select the serial port through which the computer will be connected to the DIU unit as the following: 
 

 Click the ‘Select COM Port’ button on the Toolbar. 
 Use the arrow keys to select the required port (consult your computer owner’s manual for a complete 

description of the Asynchronous Communication Ports). 
 Click OK to confirm the selection. 
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Section 5: Tutorial 

This tutorial provides an overview of the tasks you will perform most frequently using the CSS. Refer to the 
“Help on Specific CSS Tasks” section in the on-line help for a more comprehensive task list. Before you start, 
make sure the CSS is up and running. Begin by reading a codeplug from the ASTRO DIU 3000 unit and making 
a backup copy that you can use in the tutorial. 
 

Using the On-Line Help System 
The on-line help contains detailed context-sensitive help for using the CSS. To access the help system: 
 

To Access: Do this: 

General help on using 
Windows  

Click the Windows Start menu and select 
Help.  

Help contents Select Help and then Help Topics from the 
CSS main menu.  

Help on a part of the 
CSS window 

Click the ‘?’ button on the CSS toolbar and 
click the part of the window on which you 
need help.   

Help on a CSS dialog 
box 

Click the ‘?’ button in the dialog box. For 
help on parts of a dialog box, click the 
button on the dialog box title bar and then 
click the part of the dialog box for which 
you need help.  

Context-specific help 
on a CSS field 

Press the F1 key when the cursor is in that 
field. 

Help on a specific 
CSS menu Item or 
field 

Click the Help Topics button in the Help 
window, and then click the Index tab. Type 
the desired search keyword in the space 
provided. A list of topics that contain the 
search keyword appears.  

Table 9. On-Line Help System 
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Creating a Backup Codeplug File 
To create a backup file: 
 

 Open the desired codeplug file if it is not already open.  
 From the Codeplug menu, select Save As or click the ‘Save to File’ button on the Functionality Bar.  
 In the File/Save As dialog box, navigate to the drive and folder (or directory) you want to save the file.  
 Enter a new file name in the File name field and click OK to save the backup file.  

 
After the installation, the CSS uses the installation directory as the default working archive. The user can specify 
the location where to locate a file or folder.  

Reading Data from a File 
Read data from a file as the following: 
 

 From the Codeplug menu, choose Read From File, or click the ‘Read from File’ button on the 
Functionality Bar. 

 In the File/Open dialog box, navigate to the drive and folder (or directory) where the codeplug file is 
located. 

 Then double-click the desired file name, or highlight the file name and click OK. 
 The CSS displays the codeplug data in the Content View. 

After the installation, the CSS uses the installation directory as the default working archive. The user can 
specify the location where to locate a file or folder.  

Reading Data from the Device 
To read the Codeplug data from the device:  
 

 Select Read Device from the Codeplug menu or click the ‘Read from Device’ button on the 
Functionality Bar. 

 Wait while the tool is communicating with the device. After a few seconds, the CSS application will 
display the codeplug data in the Content View.  

 
If an error occurs, refer to Appendix B, Troubleshooting Information. 
 
CAUTION:  
Never disconnect the programming cable or power off the device or PC during the reading process. Doing so 
might corrupt the codeplug data. 
 



 
 
 

Part No. 6802972C90-O   (up) 17 March 2004 
 
 
 
 
 

Saving Data to the File 
To save the Codeplug data to the file, do the following: 
  

 From the Codeplug menu, select Save. 
 If this file is being saved for the first time, enter the desired file name and specify the directory where 

the file should be saved and click OK to complete the task.  
 
After the installation, the CSS uses the installation directory as the default working archive. The user can specify 
the location where to locate a file or folder.  
 

Writing Codeplug Data to the Device 
To write the Codeplug data to the device:  
 

 Select Write Device from the Codeplug menu or click the ‘Write Device’ button on the Functionality 
Bar.  

 If an error occurs, refer to Appendix B, Troubleshooting Information. 
 
CAUTION:  
Never disconnect the programming cable or power off the device or PC during the writing process. Doing so 
might corrupt the codeplug data. 
 

Printing Data from Codeplug 
To print the Codeplug data do the following:  
 

 Select Print from the Codeplug menu or click the ‘Print’ button on the Toolbar. (This option is 
available only if any codeplug is loaded into CSS.) 

 In the Print dialog box, check to see if the correct printer is selected. If not, click the Setup button and 
choose the correct printer. Click OK to return to the Print dialog box. 

 Next specify the Print range, quality, and number of copies (optional). Click OK to complete the task. 
 

Printing the Codeplug Page 
To print the current codeplug page: 
 

 Click the ‘Print page’ button on the bottom of the current codeplug page.  
 In the Print dialog box, check to see if the correct printer is selected. If not, click the Setup button and 

choose the correct printer. Click OK to return to the Print dialog box.  
 Next specify the Print range, quality, and number of copies (optional). Click OK to complete the task.  

Printing to a File 
Use this command to print out a configuration to a text file, which could be read by Notepad, Word, or another 
application.  The file is then accessible via CSS Codeplug menu for all users. 
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Appendix A:  Keyboard Shortcuts  

Any CSS function or action that can be performed using the mouse can also be performed using the keyboard 
keys. This includes accessing menu functions, navigating through the CSS, and changing field values. 
The following is A list of shortcuts for frequently used CSS functions: 
 

Press To perform this action… 
F1  Get help information 
Tab  Navigate a cursor to the next data field 
Shift+Tab Return a cursor to the previous data field 
Up Arrow  Increment an integer value of a data field 
Down Arrow  Decrement an integer value of a data field 
Left/Right 
Arrow  

Move a cursor within a data field 

Spacebar  Toggle the entry in the check box (that is, change 
Enabled to Disabled and vice versa) 

Alt+Down 
Arrow  

Open a drop-down list 

Up/Down 
Arrow  

Make a selection in an opened drop-down list 

Ins  Toggle between overwrite and insert modes 
Del  Erase a character under a cursor 
BackSpace  Erase data within a field and move a cursor left 
Ctrl+C Close a codeplug file 
Ctrl+O Read a codeplug file 
Ctrl+P Print a codeplug file 
Ctrl+S Save a codeplug file 
Ctrl+R Read codeplug data from the device 
Ctrl+W Write codeplug data to the device 
Right Arrow Expand tree—Codeplug tree navigation  
Left Arrow Collapse tree—Codeplug tree navigation 
F11 Navigate between Codeplug Tree and Codeplug 

Parameters 

Table 10. Keyboard Shortcuts 

 
Tips: 
Use these shortcuts in situations where you cannot use a mouse (for instance, programming a device in the field). 
Refer to the “Keyboard Shortcuts” section in the on-line help for a list of spreadsheet and CSS navigation 
shortcuts. 
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Appendix B:  Troubleshooting Information 

If you see this message... Do this: 
Connection failed! Check for ... 
and try again 

Check the hardware setup.  

Can't open: file is not a valid... The file you attempt to read is not the valid codeplug. Try 
reading another file.  

Can't open: File doesn't exist or has 
been corrupted! 

The file you are attempting to read does not exist. Please 
check its name and try again.  

Can't save: data was not loaded No files to save exist! This operation is illegal.  
Invalid Open Parameter.  Please check your setup again. Selected comport is 

occupied by another device or does not exist.  
Invalid File There is an attempt to save an invalid file. Please check 

the file to be saved and try again  
Access to the … is denied You are attempting to re-write read-only file. Please 

check file attributes and try again. 

Table 11. Troubleshooting Table 

 
Note: 
Many problems can be corrected if you create a backup codeplug file before modifying a codeplug. The backup 
file can be used to retrieve codeplug data if the original becomes corrupted. 
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Appendix C: Contact Information for Motorola Technical 
Support 

Motorola has made every effort to ensure that the CSS is of excellent quality. However, if you experience any 
problems with the product, we suggest that you refer to the following sources: 
 

 This guide, designed to help you install CSS and gives an overview of the CSS. 
 The on-line help which has detailed explanations. 

 
Customer Service 
 
If you encounter a problem, check your hardware setup. If the problem cannot be resolved, please call the 
System Support Center (1-800-448-3245), Monday through Friday. Please have the following information ready 
when you call: 
 

 Nature and description of the problem 
 When the problem occurred and what specific actions led to it 
 Type of PC, manufacturer, version and type of operating system, memory size, disk space 
 CSS version, radio modem type, and software version 

 
 

 
System Support Center – Toll-free 

 
1-800-448-3245 

 
Address 

 
Motorola, Inc. 
System Support Center 
1301 E. Algonquin Road 
Schaumburg, IL 60173 
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Appendix D: Acronyms and Abbreviations 

The following acronyms and abbreviations are used in this document and the CSS: 
 
APCO  Association of Public Safety Communication Officials 
CAI  Common Air Interface 
CSS   Configuration Service Software 
DIU  Digital Interface Unit 
DSP  Digital Signal Processor 
E&M  Ear & Mouth 
EMC  Encryption Module Cartridge 
FDMA  Frequency Division Multiple Access 
FIPS  Federal Information Processing Standards 
HLGT   High Level Guard Tone 
LLGT   Low Level Guard Tone 
MRTI  Mobile Radio Telephone Interface 
PC   Personal Computer 
RNC  Radio Network Controller 
RX  Receive 
SN  Serial Number 
TRC  Tone Remote Control 
TX  Transmit 



 
 
 

Part No. 6802972C90-O   (up) 23 March 2004 
 
 
 
 
 

Appendix E: Glossary 

Access Code 
A preprogrammed network access code transferred on the radio channel that allows private communication 
between end users. The access code may be PL, DPL, Single Tone, DTMF, MDC1200 or ASTRO N word. 
 
Alias (of a key index)   
An additional name consisting of alphanumeric characters, that conveniently identifies the key index (otherwise 
identified by a number). 
 
Archive  
A computer disk file that contains the codeplug data of a particular DIU. 
 
ASTRO™  
MOTOROLA Trademark for Commercial Government Industrial Solution Sector's FDMA digital radio system. 
 
Backup Files 
Additional copies of the archive files used when the original archive files are lost or erased. 
 
BPS 
A basic unit of data transmission, equal to the number of bits passing a point per seconds. 
 
Codeplug    
Data stored in the DIU's non-volatile memory and includes parameters to be used in its operation. 
 
COM 
The logical names of the standard serial port available on IBM-PC computers. 
 
Device  
The ASTRO DIU / Console device to be programmed by the CSS. 
 
Download    
The transfer of parameter information into the DIU device. 
 
Dual-tone    
A TRC command that consists of two tones. 
 
Flash Memory  
A type of non-volatile programmable solid-state memory device. 
 
Function Keys 
The keys at the left or the top of the keyboard, labeled F1-F10. 
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Appendix E: Glossary (Cont.) 

 
HLGT 
High Level Guard Tone. Enables the function tone detect circuit in a TRC base station. First tone in transmit 
sequence. 
 
LLGT  
Low Level Guard Tone. Tone that keeps a TRC base station keyed. Preceded by HLGT and a function tone(s). 
 
Multikey  
An ability of the ASTRO devices to be equipped with multiple different encryption keys. 
 
Multiple Algorithms  
An ability of the ASTRO devices to be equipped with two hardware-based algorithms. This feature supports 
interoperability and migration. 
 
Port  
A hardware interface that the computer uses to communicate with other devices. 
 
Single-tone  
A TRC command that consists of a single tone. 
 
SmartZone™  
A trunking system using multiple sites with a variable number of repeaters to cover large geographic areas. 
 
SmartNet™  
A standard trunking site that includes the Central Controller, the Base Station, and the Dispatcher Unit (console). 
 
Template  
Codeplug data used as a “master" to copy (program) to other devices. 
 
Trunking™  
A system that automatically and dynamically allocates a number of frequencies to a larger number of users, 
supplying rapid system access and optimum spectrum efficiency. 
 
Upload  
The transfer of parameter information from the DIU device. 
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